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Prepare to produce word-processed documents

The repetitive movements and sustained body position associated with entering 
data into a computer is regarded as a hazardous manual task and puts the operator 
at risk of developing an MSD. 

MSDs may include conditions such as: 
• sprains and strains of muscles, ligaments and tendons
• back injuries, including damage to the muscles, tendons, ligaments, spinal

discs, nerves, joints and bones
• joint and bone injuries or degeneration, including injuries to the shoulder,

elbow, wrist, hip, knee, ankle, hands and feet
• nerve injuries or compression (e.g. carpal tunnel syndrome)
• muscular and vascular disorders as a result of hand-arm vibration
• soft tissue hernias
• chronic pain.

Standard precautions
Your workplace may need you to use standard 
precautions, particularly work practices related to 
the prevention of repetitive strain injuries (RSIs). 
These include ergonomic practices, workstation 
design, enforced breaks and exercise routines.

Workers in an office environment follow standard 
precautions when using a computer workstation. 
However, research on sitting has demonstrated 
that other precautions also need to be considered, 
such as the use of standing workstations, to 
ensure that injuries are prevented. It is important 
that you carefully follow any standard precautions 
that are prescribed for your workplace.

Equipment and systems safety checks
An important part of your daily work routine is to check the various systems and 
equipment you will use during the day to make sure they are in correct working 
order. Your workplace policies and procedures should include the steps to follow. 
You may need to perform this procedure at the start of your working day or at 
specified intervals during the day.

Workstation safety procedure/checklist:
• Seat is positioned in front of your computer and you can reach your keyboard

comfortably.
• Computer monitor is positioned out of direct sunlight and at the correct

height.
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… continued

Head Keep your head erect.

Shoulder Have your upper arms hanging freely.

Elbow Have your forearms approximately horizontal.

Above knee Ensure there is clearance between the lower edge of the desk and 
your legs.

Below knee Ensure there is clearance between the front edge of the seat and 
the lower leg.

Footrest Use a footrest if needed.

Back of chair The back support should be adjusted to support the small of your 
back.

Under chair Adjust the seat height to suit your furniture and equipment.

Chair legs Use a chair with a five castor base.

Desktop layout

Items on your desk, including equipment and resources, should be arranged 
within easy reach.

Your desk area can be divided into three zones:
• the optimum reach zone – the area closest to you, where your hands operate

most of the time
• the maximum reach zone – further away, but still close enough to reach

comfortably
• the outer reach zone – where you may have to bend forward or stand to

reach items.

Make sure your desk is organised so that frequently used objects, such as your 
keyboard, are close to you. Intermittently used objects, such as your phone, should 
be out of the way but still within easy reach. Other resources used less frequently, 
such as in- and out-trays, should be in the outer reach zone.
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Example: fax

J C J A C K S O N P H O T O G R A P H Y
“Capturing moments for eternity”
Shop 21, Fairholme Plaza
MAROOCHYDORE QLD R558
Ph: 07 5443 4237 
Fax: 075443 4238
Email: inquiries@jcjackson.net.au
Web: www.jcjackson.net.au

To: 	 Weber Auto Repairs

Attention: 	 James Patrick

Fax number: 	 01 3847 2900

From: 	 Joshua Jackson

Date: 	 18 October 2016

Re: 	 Staff photographs

No. of pages: 1 	 (including this one)

Hi James,

I really enjoyed doing the shoot with your staff and am glad to 
hear you are happy with the proofs. We have just started a new 
promotion and I wanted to let you know about it before you place 
your order.

November/December 2016 Special

During the months of November and December, corporate 
customers placing orders valued at $1000 or more will 
receive 50 calendars featuring the workplace image of 
their choice for no extra charge. These calendars make the 
perfect gift for your valued customers. Hurry! Offer ends 31 
December.

Things are certainly getting hectic here and I would suggest you 
place your order by the end of November to guarantee delivery 
before Christmas.

Please give me a call if I can be of any further assistance.

Regards,

Joshua Jackson
Joshua Jackson

Manager

Please check that you have received all pages. 
If not, please phone 07 5443 4237.

Organisation’s letterhead

Recipient’s company name
Recipient’s name
Recipient’s fax number
Sender’s name
Date
Subject
Number of pages being sent

Greeting

Body (content)

Closing
Signature

Sender’s identification
Footer
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… continued

Example: tri-fold brochure

Did you notice that the first page looks like it is backwards? When you create tri-fold 
brochures you need to create it this way so that when it is printed double-sided the content is 
displayed correctly. If you open a brochure template in Word, you will see this is how it is laid 
out.

Forms and tables
Forms are used by organisations to record and 
collect information. Forms can be single or 
multiple pages and can be created to meet any 
need. Common forms include customer feedback 
forms, order forms and time sheets. Your word-
processing software has a range of features you 
can use to create forms, but one of the more 
popular methods is to use either one or a series 
of tables.
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Producing text documents that meet an organisation’s requirements takes more 
than just great computer skills. Every time you produce a document you should 
apply your knowledge of organisational policies and requirements to ensure your 
work conforms to the established style and company image.

Why organisational requirements are important
Production guidelines are implemented for several reasons. One of the most 
important is to ensure that documents have a consistent style and image. By 
following organisational guidelines, all staff will create documents that have a 
similar style and format. This means that customers, business associates and 
anyone receiving material from your organisation will instantly recognise it as 
belonging to your organisation.

In many cases written 
communication forms most of an 
organisation’s contact with its clients. 
Each time a client has contact with an 
organisation, they form an opinion 
based on the documents they receive. 
In some instances an unprofessional 
looking document, or one containing 
errors, can be the difference between 
gaining and losing a client.

Conforming to organisational requirements will also ensure you are able to 
complete your work in an efficient and timely manner. It is very frustrating to have 
spent hours working on the design of a document, only to find it does not meet 
requirements. To avoid a situation like this, there may be a simple template you 
could use.

1C	 Identify requirements to ensure 
consistency of style and image
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the company name, logo and telephone number, although other details may also 
need to be included. Check your organisation’s style guide and templates and 
always ask another person to review your design and finished flyer or brochure. 
Below is some useful information for producing a range of promotional materials.

Forms and tables

Just like flyers and brochures, designing new forms will require 
you to use your design skills. You will need to know if they will be 
in colour or black and white, the paper size they will be printed 
on and what information must be included. The information to be 
included may depend on whether the form is for internal company 
use or external (client) use. Check your organisation’s style guide 
and templates and always ask your supervisor to review your 
design and finished form.

Reports

You need to undertake a variety of tasks when preparing a report. 
You need to determine the complexity of the report, including its 
length, structure and the level of detail needed to suit the purpose 
and audience. See your organisation’s style guide or templates for 
the preferred layout.

Schedules

As schedules may be distributed either within an organisation or 
to external clients, make sure you follow the guidelines in your 
organisation’s style guide and templates and get your supervisor’s 
approval for the final document and distribution.

Calendars

Calendars are usually generated for the month, but can be 
customised to any length.
The easiest way to create a calendar is by using the inbuilt 
wizards in your word-processing or desktop publishing software. 
The major advantage of using these wizards is that the dates 
are automatically generated. Like schedules, calendars can be 
distributed to internal or external clients. 
To ensure you uphold the required corporate image, follow the 
guidelines in your organisation’s style guide and templates and get 
your supervisor’s approval for the final document.
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One of your main duties when working in an office may be creating and editing 
word-processed documents. To ensure you perform your duties in an efficient 
manner, you must establish the purpose, audience and information requirements 
for documents before you start creating them. In this topic you will become 
familiar with the various information requirements and design elements that must 
be considered, along with the functions you can use to ensure consistency in your 
documents.
In this topic you will learn how to:
2A	 Design the structure and layout of a document
2B	 Design the document to enhance readability and appearance
2C	 Ensure consistency of design and layout
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What information is required?
Most documents you create will have specific information that must be included 
in them. This may be information to maintain you organisation’s corporate image; 
for example, the company logo or standard headers and footers. It could also be 
information that is critical to conveying the document’s message; for example, a 
flyer about an upcoming workshop must include the date, time and venue of the 
workshop.

The design of the document will be 
determined by the information it 
contains. You need to consider the 
type of information and the clearest 
way to display it. Is the information 
communicated in graphics or text? 
Would you use bullets, tables or 
columns? Once this is clarified, you 
can identify how you will structure 
and lay out the document.

Structure and layout
After you have determined the purpose, information and audience requirements 
for the document, you can implement the design. Designing a document refers 
to the way you organise the content and layout. You should take several design 
aspects into consideration.

Design aspects to consider:

• Boxes • Colour
• Columns • Graphics, photographs and drawings
• Headings • Letter and memo conventions
• Page layout • Typeface
• White space

Boxes
Text boxes can be used to give clearly defined borders or edges to particular 
content on a page. Putting an item in a box can make it stand out. Using design 
elements – such as boxes –consistently on a range of documents can help the 
audience to quickly locate information they have a particular interest in. An 
example of this is displaying small advertisements in a newsletter. If you use the 
same positioning and boxed design in each edition, readers will learn to look for 
the information in that format. 
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Table headings
You can have tables that are larger than one page when creating documents. You 
can use the Heading Rows Repeat command to automatically show the table 
headings on each page.

You might use this command when you have a document that contains a client list, 
as shown below. The column headings have been automatically repeated on each 
page, making the information easier to understand.

Create a Heading Rows Repeat

Note: This command only works for automatic page breaks. It will not work if you 
insert manual page breaks within your table.

1. Create a table.

2. Select the rows that you want repeated at the top of each page. You must
include the first row in the table.

3. Click the Layout tab, and then click Repeat Header Rows. The heading rows
will now be repeated on each page.

Note: This toolbar is only available if you are in a table.

AutoFormat
The AutoFormat feature in Word allows application of predefined styles to 
documents. The styles you can choose from are a standard component of Word. 
You can also create your own templates and styles. 
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Use functions for efficiency and consistency
Using various text, graphic and page formatting options will help you increase 
your efficiency and consistency.

You should become familiar with each of the following functions: 

• Indentations • Spacing
• Page numbers • Typeface styles, point size and colour
• Captions • Bullets and numbering
• Footnotes or endnotes • Annotated references
• Borders

Indentations
The indent of a line of text or paragraph is how far it is positioned from the 
margin. Text can be indented on either the left or right sides of the paragraph or 
both. Indenting is useful for drawing attention to sections of text. It can be used 
very effectively to emphasise lists of data, including bulleted lists.

Indent a section of text

From the Ribbon, choose Page Layout, and go to the Paragraph grouping.

Enter the indent amounts and choose the special type if applicable.

Click OK. 

OR

Click the small downwards arrow next to Paragraph on the Home tab and the 
following dialogue box will appear.
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Example: organisational style guide
Here is an example of a style guide for Techno Train.
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Using the menu

Select a column or row to resize.
From the Ribbon, choose Table Tools, select Layout. Use the 
pull-down menu, from the Cell Size grouping to access Table 
properties.
Experiment with the AutoFit, Sizes and Distribution (makes all 
columns or rows equal).
If you click the drop-down menu you can click on the Previous 
Column or Next Column buttons to change the width of adjacent 
columns.
Select row and repeat these actions to modify its size.

Using the ruler

This applies to columns only. Move the pointer to the hashed area 
on the ruler to resize. The pointer will change to a double-headed 
arrow.

(Note: This method will maintain the width of adjacent columns.)

Use the Table Tools Design tab

The Design tab in Table Tools can be used to perform a range of formatting tasks 
on tables.

Note: This tab is only available if your cursor is in a table.

Use the different options to experiment with table design and style.

Format table borders

You can apply a variety of different borders to table cells. It is also possible to select 
which parts of one cell have borders displayed. 
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Using the mouse to delete rows

└└ 1. �Position your pointer on the left edge of a row and the pointer
will change to a white  arrow. Click the left mouse button and 
the row will be selected.

└└ 2. �Click the right mouse button and select Delete Rows. The
selected row will be deleted.

└└ 3. Use the menu to insert or delete rows or columns.

└└ 4. �From the Ribbon, choose the Table Tools tab, and select the
Layout tab.

└└ 5. Select Rows & Columns.

└└ Experiment with the options.

Practice task 10 
Using the instructions provided in this section, create a table with seven rows and three 
columns. Edit the table so that it is similar to this example. Save and print your document with 
the name ‘Table Practice’.
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Example: image and text wrapping interactions
The following example shows the way the graphic and text interact using each different text 
wrapping style.

Adjust the text wrapping properties of a graphic

1. Click on your graphic and go to the Ribbon, then choose Picture
Tools, Format.

2. Choose the  Wrap Text button and click on the style you want to apply.

3. Move the graphic into the desired position.
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This learning checkpoint allows you to review your skills and knowledge in adding 
tables and other data.

Part A
Produce a document similar to the following example. You will need to search for 
similar Clip Art images to use in the document. Your document should use the 
same layout (positioning of text and images), similar heading styles, tables and 
margins. Ensure you create appropriate styles to support the formatting of the 
document. Save the document as ‘Capricorn newsleter.docx’ and print it.

Learning checkpoint 3 
Add tables and other data
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… continued

Practice task 15 
7. Create a recipient list with the following information. Remember to customise your address

list first.

Company

Name

Address City State Post 
code

First 
name

Surname Current

Henderson 
Printers

PO Box 
522

MAROOCHYDORE QLD 4558 Alex Bolton $10000

Ingles 
Accounting

28 
Melville 
Street

NOOSA QLD 4566 Susan McFee $4000

John 
Marcus & 
Sons

PO Box 
193

BEERWAH QLD 4519 John Marcus $8000

8. Type these details into the fields. When entering data, you can either click into each field
using the mouse or use the Tab and Enter keys on the keyboard to jump from field to field.
To create a new record, click New Entry after you have entered a record. When you have
finished entering all the details, click OK. When you do this, you will be prompted to save
the list. Choose an appropriate location for the list file. Choose an appropriate name for
the recipient list. Click Save.
Word has a range of default locations for saved files. The default location for data sources
is Libraries\Documents\My Data Sources. When you insert or save a data source, this is
the location Word will automatically look in. If you have an existing recipient list, when you
choose Use an Existing List from the Select recipients panel, the browse tool’s default
location is also Libraries\Documents\My Data Sources.

After you have saved your recipients list, when you open this file the information appears 
in the Mail Merge Recipients window. In this window, you can choose which entries to 
include in the mail merge by checking (ticking) or unchecking the box beside the first field. 
This option is useful because data sources or recipient lists often contain hundreds of 
records.

continued …
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Here are some other considerations to prevent data loss.

Exiting application

When finishing work on a document you need to exit the 
application. This maintains security and frees up computer 
resources, such as memory, for other applications.

Multiple files

Try to work on one document at a time. If you need to have 
multiple applications open, make sure you close the applications 
that are no longer needed. This will help your computer to work 
more quickly and prevent data loss if the computer fails.

Unattended workstation

Data loss can also occur if someone else tampers with your work. 
If you are working on a document at your workstation, you should 
lock your computer or exit the application before leaving your 
workstation unattended.

Software

Other causes of data loss include virus damage, operating system 
or application software bugs and failed upgrades.

Hardware

If your computer starts to make unusual noises or display warning 
messages, shut it down immediately and do not power up again 
until you have received advice from the IT coordinator.
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Summary

1. Use advanced software functions to produce documents efficiently.

2. Enter and import text to enhance your documents.

3. Editing ensures that the document is grammatically correct, has an effective
design and meets organisational requirements.

4. A checklist is often used to help people systematically go through all the points
that need to be considered when editing a document.

5. A range of print options are available when printing a document.

6. Most organisations have folder structures and naming standards. This allows
users to set up folders quickly and easily.

7. Naming methods need to be kept consistent, simple and meaningful.

8. Hard-copy documents need to be kept and archived, or destroyed after the
appropriate period of time.

9. Make sure you exit applications without causing damage or data loss.

10. A time line sets the schedule for a task or project. It gives details of each task
that needs to be accomplished to achieve that goal.

11. Time lines are often set by other people in your organisation. To successfully
meet these requirements you need to define the scope of the document.

12. Use online and paper-based manuals and other training materials to overcome
problems with document design and production.
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Recipient data:

First name Surname Fax number

Wafah Dafour 07 5423 0987

Jacob Shelby 07 3645 0978

Vladimir Klimovitch 07 4164 5632

Ryan Wheelan 07 5419 0088

Charlotte Johnson 07 4162 3277

Page 2
• On the second page of the same document create a flyer containing the

specials information shown below.
• Ensure you create a professional design that adheres to design principles

outlined in Topic 2.

3. Insert the pictures of the fruits and vegetables into the flyer from plant-
paradise-images.docx. Access and download this by either scanning the QR
code provided or at: http://chilp.it/6b8c562.
• The flyer should be on A4 paper, have a border and the margins

should be 1 cm on all sides. Do not change the margins on the
fax cover sheet.

• Ensure you include the company name, phone number and
website address on the flyer.

Summer Specials
Sweet corn
Sweet corn fresh from the garden is one of summer’s great treats. Sweet corn 
should be planted in blocks of several rows close together for best pollination. 
Single-row plantings can result in poor kernel set. Pick and use immediately 
for maximum sweetness.
Pumpkin
These summer favourites come in a huge range of varieties. They are easy to 
grow, and love heat and regular water. Varieties available include Butternut, 
Jarradale, Ken Special and Queensland Blue. For best results plant on small 
mounds in groups of three.
Elderberry (new)
This easy-to-grow clumping tree has attractive white flowers followed by dark 
purple berries. Harvest the berries to make a tangy jam. Berries can also be 
used to produce either sparkling or still wine.

http://chilp.it/6b8c562
http://aspire-bizops-docs.s3.amazonaws.com/student-files/bsbitu303-plant-paradise-images.docx
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